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Operation Manual
For your own safety, please read this operation manual carefully before initial operation! All per-
sons involved in the installation, setting-up, operation, maintenance and service of this device 
must be appropriately qualified and observe this operation manual in detail. This product complies 
with the requirements of the applicable European and national regulations. Conformity has been 
proven. The respective statements and documents are deposited at the manufacturer.

Congratulations on purchasing your Reloop Spin! 2 system. Thank you for placing your trust in our 
disc jockey technology. Before operating this equipment we ask you to carefully study and observe 
all instructions. Please remove the Spin! 2 interface from its packaging. Check before initial opera-
tion to make sure that the device has not been visibly damaged during transport. If you detect any 
damage to the power cable or the casing, do not operate the device. Contact your specialised dealer.

SAFETY INSTRUCTIONS

CAUTION!
Please exercise particular caution when handling 240 V power voltage. This voltage rating may 
lead to a critical electrical shock! Any damage caused by the non-observance of this operation 
manual excludes any warranty claims. The manufacturer is not liable for any damage to property 
or for personal injury caused by improper handling or non-observance of the safety instructions.
- 	 �This device left the factory in perfect condition. To maintain this condition and to ensure a risk-

free operation the user must observe the safety instructions and warnings contained in this ope-
ration manual.

- 	 �For reasons of safety and certification (CE) the unauthorised conversion and/or modification of 
the device is prohibited. Please note that in the event of damage caused by the manual modifica-
tion to this device any warranty claims are excluded.

- 	 �The inside of the device does not contain any parts which require maintenance, with the excepti-
on of wear parts that can be exchanged from the outside. Qualified staff must carry out mainte-
nance, otherwise the warranty does not apply!

- 	 �The Fuse must exclusively be exchanged against fuses of the same class, with the same trigger 
features and nominal current rating. 

- 	 �Ensure that the power will only be supplied after the device has been fully set up. Always plug in 
the mains plug last. Ensure that the mains switch is in the “OFF” position when connecting the 
device to power.

- 	 �Only use cables that comply with regulations. Observe that all jacks and bushes are tightened and 
correctly hooked up. Refer to your dealer if you have any questions.

- 	 �Ensure that when setting up the product the mains cable is not squashed or damaged by sharp 
edges.

- 	 �Prevent the mains cable from coming into contact with other cables! Exercise great care when 
handling mains cables and connections. Never touch these parts with wet hands!

- 	 �Connect the power cable exclusively to appropriate shock-proof outlets. The only supply point to 
be used is a supply outlet in accordance with specifications of the public supply network.

- 	 �Disconnect the device from the supply outlet when not in use and before cleaning! Be sure to hold 
the mains plug by the body. Never pull the mains cord!

- 	 �Position the device on a horizontal and stable low-flame base.
- 	 Avoid any concussions or violent impact when installing or operating the device.
- 	 �When selecting the location of installation make sure that the device is not exposed to excessive 

heat, humidity, and dust. Be sure that no cables lie around openly. You will endanger your own 
safety and that of others!

- 	 �Do not rest any containers filled with liquid that could easily spill onto the device or in its imme-
diate vicinity. If, however, fluids should access the inside of the device, immediately disconnect 
the mains plug. Have the device checked by a qualified service technician before re-use. Damage 
caused by fluids inside the device is excluded from the warranty.

- 	 �Do not operate the device under extremely hot (in excess of 35° C) or extremely cold (below 5° 
C) conditions. Keep the device away from direct exposure to the sun and heat sources such as 
radiators, ovens, etc. (even during transport in a closed vehicle). Never cover the cooling fan or 
vents. Always ensure sufficient ventilation.
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- 	 �The device must not be operated after being taken from a cold environment into a warm environ-
ment. The condensation caused hereby may destroy your device. Do not switch on or operate the 
device until it has reached ambient temperature!

- 	 �Controls and switches should never be treated with spray-on cleaning agents and lubricants. This 
device should only be cleaned with a damp cloth. Never use solvents or cleaning fluids with a 
petroleum base for cleaning.

- �	 When relocating, the device should be transported in its original packaging.
- 	 �When starting operation, the crossfaders and volume controls of your amplifier must be set to 

minimum level. Bring the loudspeaker switches into the “OFF” position. Wait between 8 to 10 
seconds before increasing the volume to avoid shot noise created by transient effect, which could 
cause damage to loudspeakers and the diplexer.

- �	 �Devices supplied by voltage should not be left in the hands of children. Please exercise particular 
care when in the presence of children.

- 	 �At commercial facilities the regulations for the prevention of accidents as stipulated by the orga-
nization of professional associations must be observed.

- 	 �At schools, training facilities, hobby and self-help workshops the operation of the device must be 
monitored with responsibility by trained staff.

- 	 �Keep this operation manual in a safe place for later reference in the event of questions or prob-
lems.

APPLICATION IN ACCORDANCE WITH REGULATIONS

- 	 �This device is a professional digital timecode system that can control software via the included 
timecode vinyl records and CDs respectively. The device should be connected via USB cable to a 
computer.

- 	 �This product is authorised for connection to 240 V, 50 Hz AC and is designed exclusively for in-
door application.

- 	 �If the device is used for any other purposes than those described in the operation manual, da-
mage can be caused to the product, leading to exclusion of warranty rights. Moreover, any other 
application that does not comply with the specified purpose harbours risks such as short circuit, 
fire, electrical shock, etc.

- 	 �The serial number determined by the manufacturer must never be removed to uphold the warran-
ty rights.

MAINTENANCE

- 	 �Check the technical safety of the device regularly for damage to the mains line or the casing, as 
well as for wearout of wear parts such as rotary and sliding switches.

- 	 �If it is to be assumed that a safe operation is no longer feasible then the device must be discon-
nected and secured against accidental use. Always disconnect the mains plug from the outlet!

- 	 �It must be assumed that a safe operation is no longer feasible if the device bears visible defects, 
if the device no longer functions, following longer storage under unfavourable conditions or after 
major transport stress.

-	 This manual, video tutorials, tips and tricks and additional downloads can be found on:

www.reloop-spin.com
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Minimum System Requirements:

PC:
•	Current processor (Pentium III, 1 GHz recommended)
•	Windows XP (SP2 or higher), Vista (SP1 or higher) operating system 
•	Free USB-Port
•	1 GB RAM
•	Sufficient free hard disk space for music files

1. Connection and Software Installation 

1.1 Connections
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Designations

Rear Side:
1. 	 Phono/Line Audio Inputs
2. 	 Phono/Line Switch
3. 	 GND Grounding Screws
4. 	USB Port
5. 	 USB Status LED
6. 	 Input Gain Knob
7. 	 ON/OFF Button
8.	 Mains Input

Front Side:
9. 	 Line Audio Outputs
10. 	Through Outputs
11. 	6.3 mm Headphones Input
12. 	Direct Button
13. 	Headphones Gain Knob
14. 	Headphones Split Knob
15. 	Microphone Input
16. 	48 V Phantom Power Button
17. 	48 V Phantom Power Status LED
18. 	Microphone Gain Knob
19. 	6.3 mm Mic Through Inputs
20.	Mic On Button

Surface:
21.	FX1 / Spin Mode Knob
22.	FX2 / Pitch Mode Knob
23.	FX3 / Reloop Knob
24.	Loop / Exit Button
25.	- / Loop In Button
26.	+ / Loop Out Button
27.	Match Button
28.	Load 1 / 2 Buttons
29.	Trax Encoder
30.	Signal Input LEDs
31.	Signal Output LEDs
32.	Cue / Set Button
33.	Shift Button

Lateral View:
34.	Kensington Safety Slot

a) 	�Connect your turntable‘s or CD player‘s outputs to the corresponding inputs (1 or 2) of the Reloop 
Spin! 2+ Interface -1-. If required connect your turntables to the GND grounding screw -3-. Depen-
ding on the connected player de-/activate the phono pre-amp -2-. Adjust the signal input volume 
with the Input Gain Knob -6-. This adjustmetn can vary depending on the connected medium.

b) 	�Connect the line outputs -9- of the Spin! 2 Interface with the line inputs of your mixer. In order to 
loop through a conventional vinyl signal connect the Through Outputs -10- with the phono inputs 
of your mixer. This way it is possible to switch between the timecode and analogue vinyl signal by 
simply using the phono/line switches.

	 NOTE!	
	 �The Signal Input LEDs 1, 2 -30- light up when there is an incoming signal. The Signal Output 

LEDs -31- light up when there is an outgoing signal.

c) 	�You can connect a microphone to the Microphone Input -15-. If you use a studio condenser micro-
phone you can activate the rquired phantom power by pushing the 48 V Phantom Power Button 
16-. The 48 V phantom power status LED -17- lights up when this function has been activated. 
With the Mic On button -20- you can turn the microphone on and off respectively.

	 NOTE!
	 �The microphone input is coupled with the stereo RCA input 1. If turned on input 1 will be blo-

cked.

	 �With the Microphone Gain Knob -18- you can adjust the volume. Connect a 6.3 mm jack cord to 
the Mic Through Input -19- and the microphone input of your mixer in order to loop through the 
microphone signal directly. This way you can on the one hand record the microphone signal via 
the software and on the other hand you can directly tap the microphone signal at your mixer.

d) 	�You can connect your headphones to the Headphones Input -11-. Adjust the volume via the Head-
phones Gain Knob -13-. Via the Headphones Split Knob -14- you can either monitor output 1 (left 
position), output 2 (right position) or both outputs (middle position). With activated Direct func-
tion -12- the inputs can directly be monitored without any latency.

e) 	�Connect the enclosed USB cord to the USB Port -4- of your Spin! 2 Interface and a free USB port 
of your computer. Connect the mains input -8- to the mains cord and a power outlet. Turn on the 
interface by pushing the ON/OFF button -7-. You can connect a safety cord to the Kensington 
Safety Slot -34-. 
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Now the following messages should appear on your monitor (example for XP):

New hardware found – Reloop Spin! 2 Interface

New hardware found – USB audio device

New hardware found – Your new hardware is installed and ready to use.

NOTE!
The basic installation of your Spin! 2+ Interface under Windows XP & Vista is carried out as Plug 
‚N‘ Play without the need for special drivers.

connections
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1.2 Spin! 2 Software Installation 

After having carried out the hardware setup you can now continue with the software and ASIO driver 
installation. To do so please insert the Spin! 2 installation CD in the CD ROM drive of your computer. 
If the setup does not start automatically please carry out the file 

„Install_reloop.exe“ manually.

Choose the installation language and confirm with „OK“.

Read and accept the licensing agreement.
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Now you have to enter your name, company if desired, e-mail address (required) and the serial num-
ber. You can find the serial number on the back side of the Spin! 2 installation CD-cover. Confirm the 
entries with „Next“.

Now choose the installation directory where you would like to install your Spin! 2 software or use the 
standard directory (recommended). Please confirm with „Next“.

After a successful installation you should now install the ASIO driver for your Spin! 2+ Interface. To 
do so click on „Install Spin! 2 ASIO driver“ and „Install Spin! 2+ ASIO driver“ respectively (depending 
on the purchased interface version).
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1.3 ASIO Driver Installation

After the ASIO setup menu appears, first choose your language.

As second step click on „Install driver“.

If your Spin! 2+ Interface has not been connected yet you will be asked to do so now, as displayed 
below. Now the ASIO drivers are being installed.

You may be asked to disconnect the USB cord from the interface and then to re-plug it. In order to 
finalize the ASIO installation you should reboot your computer.
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64 bit driver
On the CD you can also find ASIO drivers for 64 bit systems which you can execute manually if 
desired.

Support & Updates
Log regularly onto www.reloop-spin.com for all the latest updates.

1.4 Easy Setup

When starting Reloop Spin! 2 for the first time the easy setup will start automatically.

NOTE!
You can also carry out the setup manually under the menu item > Help > Easy Setup!

1. Resolution
In this first step please choose the screen resolution.

2. Calibration Input 1
Now you have to carry out the calibration. Choose the according playback device. Switch to play 
mode and click „Next“.
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3. Calibration Result for Channel 1
After a successful calibration the message „Spin! has been calibrated successfully“ should appear.

NOTE!
If the message „Spin! has not been installed properly“ should appear please check your connec-
tions or change your turntables’ needles.

4. Calibration Input 2
Please choose the same adjustmetns for your second playback device.
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5. Calibration Result Input 2
A successful calibration result should appear here as well.

NOTE!
The calibration is only necessary when using turntables. When connecting CD players this step 
will be left out.

6. If the setup has been successful your entries will be confirmed. 
Close the easy setup by clicking „Finish“.

NOTE!
In order to optimise Spin! 2 there are three possibilities in the last installation step.
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1. Sound Before Graphic Priority
If this function is activated the sound performance will be assigned before graphics. This is an ad-
vantage when using older or inefficient computers (when experiencing dropouts for example).

2. Tick Scrolling
The waveform remains still. The line (corresponds to the needle‘s position) moves.

3. BPM and Waveform
If this option is activated Spin! 2 determines the BPM and waveforms when loading a track.
(default and recommended)

1.5 Required Software Settings for Startup

Following, the first necessary steps in order to be able to directly work with the Spin! 2 software will 
be explained.

NOTE!
The complete manual can be found following the menu > Help > Manual.

a) 	Importing Music
	 �First import all your music to the Spin! Library. To do so go to the menu item > Spin! Library > Auto 

Search.

	 �It is possible to either search for single folders or directories automatically for music. Confirm 
your choice with „OK“.

b) 	Loading Tracks
	 �After having imported all your music you can load single tracks into player 1 and 2. There are 

three possibilities to do so:

•	 Via mouse
	 Use the drag & drop function in order to load a track to a player.

•	 Via Trax Select
	 �On the Spin! 2 timecode record‘s B-side the last groove has been conceived for 	 sea rch i ng 

tracks. Drop the needle on this groove in order to browse the Spin! library. Stop the record at the 
desired track and put the needle back to the beginning of the record in order to load the desired 
track.

•	 �Via Keyboard
	 �Browse the Spin! library with the up/down cursors to the desired track and push enter in order to 

load this track. The active player can be selected via the TAB key.

c) 	�Activating the Timecode Mode
	 Activate the Timecode Mode via the „Vinyl“ button, right below the label monitor.

• 	 Via Trax Wheel
	 �Navigate through the Spin! Library by turning the Trax Wheel and load the desired track via the 

load buttons.

	 Now you can start mixing.
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1.6 Interface Controller 

With your Spin! 2+ Interface it is possible to directly control the most important software functions 
without having to use the mouse. The control elements will be explained in detail below.

a)	Track Browsing & Beat Match
	 �By turning the Trax Encoder -29- you can navigate through the Spin! Library. By pushing the Load 

Buttons -28- you can load a track to the corresponding player. If desired you can synchronise a 
track with the opposing one at the push of a button by using the Match Buttons -27-.

b) 	Cue & Loop Section
	 �By pushing the Shift Button -33- and the Cue / Set Button -32- you can set a cue point. In order 

to call up the last set cue point push the Cue / Set Button -32-.

	 ��Push the Loop button -24- in order to set an automatic beat loop. Via the +/- buttons -25/26- 
you can adjust the bar length. By pushing the Loop Button -24- again you leave the beat loop. In 
order to set a manual looppush the Shift Button -33- and the In Button -25- for the Loop In Point 
and Shift -33- and the Out Button -26- for the Loop Out Point. You can leave the manual loop by 
pushing the Shift Button -33- and the Exit Button -24-.

c) 	Effect & Mode Section
	 �Via the effect knobs FX 1-3 -21, 22, 23- you can adjust the three master effects. In order to change 

the Spin! Mode hold the Shift Button -33- and turn the Spin! Mode Knob -21-. You can change the 
Pitch Mode by holding Shift -33- and turning the Pitch Mode Knob  -22-.

	 Activate the Reloop Function by holding the Shift Button -33- and turning the Reloop Knob -23-.

NOTE!
Visit www.reloop-spin.com regularly for video tutorials and updates.

2. Software General Survey
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1. Shortcut: New Spin! Library
Here you can create a new, empty library that can be filled with audio files as required.

2. Shortcut: Open Spin! Library
Opens an existing library.

3. Shortcut: Auto Search
In order to import a bulk of audio files you can comfortably browse your hard disk or, if requi-
red, single directories via this function.

4. Shortcut: Save Spin! Library
Saves your library.

5. Shortcut: Stop Spin! List
Stops the playback of a Spin! List.

6. Shortcut: Play Spin! List
Starts the playback of a Spin! List.

7. Shortcut: Loop Spin! List
The Spin! List will be repeated in an endless loop.

8. Shortcut: Shuffle Spin! List
A random playback of the Spin! List will be started.

9. Shortcut: Previous
Load the previous track from the Spin! List to your player.

10. Shortcut: Next 
Load the next track from the Spin! List to your player.

11. Shortcut Music Explorer / Audio Input
Fades the Music Explorer / Audio Input view in and out.

12. Shortcut: Spin! Library
Fades the Spin! Library in and out.

13. Shortcut: Spin! List
Fades the Spin! List in and out.

14. Shortcut Category View
Fades the Category View in and out.

15. Shortcut X-Fader Match View
Fades the X-Fader Match View in and out.

16. Shortcut: Master/Rec. Volume
Fades the Master/Rec. Volume View in and out.

17. Shortcut: Beat Match View
Fades the Beat Match View in and out.

18. Shortcut: Options
In this option menu you can carry out a variety of adjustments. Further information regarding 
this matter can be found in the chapter 4.1 in this manual.

19. Free MIDI Learning
Activates the MIDI learning mode. Please refer to chapter 4.4 for further information.

20. Safe Mode
If the Safe Mode is active it is not possible to load a track to the currently active player. This 
prevents unwanted loading of new music when using a player.
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21. Beat Match View
The Beat Match View shows you the peaks of both tracks – the two displays are arranged vis-à-vis. 
It is possible to quickly recognize whether bass drums and snares are running simultaneously. This 
way, if the two tracks have been matched regarding the pitch, it is possible to easily and quickly 
synchronise two tracks. The left player 1 is displayed green and the right player 2 is displayed grey.

By activating the Bar function (menu item 3.5 Spin! Workspace, subitem 3.5.3 Bar) the advanced 
Beat Match View will be displayed.

a) 	Peaks
	 Display of the wave peaks.

b) 	4/4 Bar Counter
	 �The four small boxes indicate the 4/4 bar. With each bar a further box will light up. With this help 

you can bring in the track according to the first of four beats.

c) 	Beat Bars
	 �Display the single beat bars synchronically to the peak display.

	 NOTE!
	 �If the Beat Bars are not correctly in line with the peak you can adjust this in the Needle View. 

To do so hold the displayed bar in Needle View with the mouse and drag it accordingly to the 
left or right.

d) 	16 Bar Counter
	 �This numeric display counts each 16 bars. If for example a 7 is displayed, 7 bars of the track have 

been played. As usually every 16 bars there is a change of the suspense curve (breaks, effects, 
etc.) you can use this help as mix staring point.

e) 	Zoom Adjustment
	 Here you can adjust the zoom factor of the Beat Match View.

22. Complete View
In the Complete View you can see the complete waveform of a track. The dramatic arch of a track 
can be recognized well and at the blink of an eye you can also see where the intros and breaks are. 
The elapsed part of a track is displayed green and the remaining part of a track is displayed grey.

23. Needle View
The zoom range can be adjusted from 2 – 16 beats. To do so click the right mouse button in needle 
view and select the according value from the submenu. Furthermore you can choose whether the 
left, right, stereo or both channels mixed should be shown in the waveform. Select the according 
option with a right mouse click in Needle View.

B

C A D D
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There are two types for the Needle View display:

• 	 Waveform Scrolling
	 �The waveform moves. A vertical line in the middle represents the needle.

• Tick Scrolling
	 �The waveform remains still. The line (corresponds to the needle‘s position) moves.

NOTE!
This option is system-resource saving.

Select the corresponding option with a right mouse click in Needle View.

24. Master
Adjust the master volume for player 1 and player 2 respectively.

25. Mic Rec. Function
Due to the integrated Mic Rec. Function (Mic Spin!) you can record a sample via microphone that can 
later be used for scratching for example.

Follow these steps:
Sample recording	
•		 �Under Audio Input (Music Explorer) assign the input “0: Reloop Spin! 2- Interface 1” via drag & 

drop to one of the players
•		 Adjust the volume level via the mic volume knob
•		 Push the Rec button
•		 A save dialogue will appear; enter name and position where the sample should be stored
•		 �After pushing “save” the recording will start; stop the recording by pushing the Rec. button once 

more

Mic Spin! function (playing and scratching a sample)
•		 �Via drag & drop assign a desired track from the Spin! Library or the recorded sample to a player 

in order to manipulate it via record.

NOTE!
The mic input is coupled to the input 1. As soon as you connect the microphone the phono/line 
input 1 is deactivated. If you would like to record a mic smaple during a mixing session make sure 
that player 2 is currently playing. After recording disconnect the microphone in order to be able 
to control player 1 via records.

26. Load Track
With this function it is possible to load single files to the player.
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27. Bypass Function
If the Bypass Function has been activated the input signal of the Spin! 2+ Interface will be directly 
routed through the software. Deactivate the bypass function for timecode use.

28. Label Monitor
The Label Monitor is a kind of virtual record that moves along according to the timecode record. 
Each movement that is made with the record will be carried out synchronously to the Label Monitor. 
The Label Monitor is a helpful marker for beat juggling.

29. Gain Knob
The Gain Knob is, similar to a mixer, the final amplification of a channel. Tracks of a different recor-
ding volume level can be adjusted to one another without increasing the master volume.

NOTE!
Under > File > Options > Rider „BPM and Tools!“ > item “Auto BPM” you can activate the auto gain 
function. This way the gain values of the tracks will be adjusted automatically without any further 
need for manual adjustment.

30. Pitch Mode
You have the possibility to select two different Pitch Modes via the pitchfader -31-. You can change 
the mode by clicking the -30- button.

a) 	Speed Mode
	 �If Speed Mode has been selected you can adjust the pitch like with a normal turntable. Within the 

adjusted pitch range the current value is also shown in the Info View -51-, position -7-.

b) 	Master Tempo Mode (MT)
	 �If the Master Tempo mode has been activated it is possible to change the pitch via the pitch fa-

der -31- ranging from -/+6% without influencing the tone pitch. This means that the tone pitch 
remains the same when changing the pitch.
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31. Pitchfader
The pitch fader represents a conventional pitchfader of a turntable or CD player. When in Timecode 
Vinyl mode -32- the fader moves synchronously to the adjustments made with the turntable. This 
depends on the adjusted pitch mode (see point 30). In deactivated Timecode Mode the pitchfader 
can also be moved via the mouse.

32. Vinyl Timecode Activation
Via this button you can activate the Timecode Mode, which means that an operation via timecode 
records and CDs becomes possible. If this button is deactivated it is only possible to control the 
software via the mouse.

33. Spin! Mode Button
By using this button you can choose between the playback modes Spin! Mode, Classic Spin!, Advan-
ced Spin! and Battle Spin!.

a)	Classic Spin!	
	 �The audio files will be played from beginning to end, just like a normal record (needle drop). Clas-

sic mixing and scratching are possible but without the loop, cue points and effects options.

b) 	Advanced Spin!
	 �In this mode needle drop is also possible. But it is commensurate to the vinyl record‘s length. So 

if you would like to jump to the middle of a song, you have to place the needle in the middle of the 
record. Classic mixing and scratching are possible; loops, cue points and effects are available.

c) 	Battle Spin!
	 �No needle drop is available here. This means that the track will always continue no matter where 

the needle is placed on the record. This mode is appropriate for scratching even if the needle 
should skip. Battle mixing is possible; loops, cue points and effects are available.

34. Play/Pause Button
By pushing this button you will start the previously selected track. This function is only available in 
PC controll mode.
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35. Cue Button
By using this button you will change to Cue Mode. There are two possibilities in order to set a cue 
point.

a) Cue Pause
In playback mode push the Play/Pause Button -34- in order to change to pause mode. Now push the 
cue button in order to set a cue point.

b) Loop In
During playback or in pause mode you can push the Loop In button in order to set a cue point.

36.Forward and Reverse Button
Via this button you can determine the playback direction of the track (forward or reverse). In Time-
code Mode this button shows the direction the records moving in.

37. Skip Buttons
Push these buttons in order to load the previous or next track from your Spin! Library.

38. Fast Search Buttons
Via these buttons it is possible to fast search within a track. In Timecode Mode this function is deac-
tivated.

39. Pitch-Bend Buttons
Activate the pitch vernier adjustment via the Pitch Bend Button. By pushing and holding these 
buttons you can temporarily increase or decrease the pitch. Release the button and the player will 
return to the pitch that has previously been set via the pitch fader. 
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40. Spin! Library
In this browser you will find all necessary information regarding the tracks of your Spin!  Library. 
In order to directly select a track from the library click on the corresponding track and move it via 
drag & drop to the desired player. Alternatively you can also choose the track select function via the 
timecode record (see chapter 1.5, item b). 
Via the hot key “V” you can activate the Spin! Library in order to navigate the library via the up/
down cursor buttons. By pushing enter you can assign the track to the active player. Via the TAB 
button you can select between player 1 and player 2.

a) Search Filter
In this field it is possible to search for a track by entering some letters. The more precise the input 
the more precise the result will be.

b) Exact Match
If this option is activated only exact results corresponding to the entry will be shown.

c) Selection Filter
Here you can define selection filters that should be searched for.

a

d

b c

• 	 All
	 �Via this filter all categories will be observed 

while searching.

• 	 File
	 �If this filter is active only file names will be 

considered while searching.

• 	 Title
	 �If this filter is active only title names will be 

considered while searching.

• 	 Artist
	 �If this filter is active only artist names will be 

considered while searching.

• 	 Album
	 �If this filter is active only album names will be 

considered while searching.

• 	 Genre
	 �If this filter is active only genres will be consi-

dered while searching.

• 	 Remix
	 �If this filter is active only remix names will be 

considered while searching.

• 	 Year
	 �If this filter is active only years will be consi-

dered while searching.

• 	 BPM
	 �If this filter is active only BPM values will be 

considered while searching.

• 	 Directory
	 �If this filter is active only directory names will 

be considered while searching.

d) Categories
In this view all information regarding a track, like title, name or BPM is displayed. You can define the 
categories on your own by clicking the right mouse button in the category bar (columns properties).

• Title
• Artist
• Album
• Genre
• BPM
• Duration
• Last Played

• Remix
• Rating
• Comments
• Year
• Track
• File
• Directory

• File Name
• File Extension
• Date Created
• Label
• Producer
• Key
• Counter
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NOTE!
You can edit every bit of information regarding the track on your own by double clicking the mouse 
in the corresponding category field. If you wish to save these attributes (ID3 TAG) permanentely 
for a track, go to the menu and click on the corresponding track 

> Track > Save ID3 TAG attributes.

Via a right mouse click in the Spin! Library you can access a submenu that includes the following 
options:

Add Track
With this function you can add single tracks to 
your library.

Auto Search
In order to import a bulk of audio files you can 
comfortably browse your hard disk or if required 
single directories via this function.

Track Preferences
You can carry out track-specific adjustments 
here.

Show In Windows Explorer
Finds and shows the marked track in Windows 
Explorer.

Analyse BPM Manually 
Via this tool you can manually determine the 
BPM value. This can be achieved by either cli-
cking on the space button with the mouse or by 
pushing the space bar. The longer you push the 
according button to the beat the more precise 
the calculated value will be.

Analyse BPM Automatically
Via this function the BPM value will be calcu-
lated automatically although beats cannot be 
recognized by the software if the beat does not 
stand out enough from the rest of the track in 
order to be identified as rhythm element. 4/4 
beats are ideal for the Reloop Spin! 2 software.

Select All
All tracks of the current Spin! Library will be 
marked.

Delete
Delete all marked tracks from the Spin! Library.

Add to Spin! List
The marked tracks will be added to the Spin! 
List.

Group
Via this function you can assign or delete marked 
tracks of a previously created group/playlist. For 
further information please alo see item -52-.

List View
All categories of a track are displayed in this 
view. The categories can be defined via the Co-
lumn Properties function (see below)

Column Properties
As already explained, here you can fade in and 
out single categories.

Album Artwork
The album Artwork displays album covers. This 
way you can flip through the records visually 
just as it is known from record crates.

41. Flanger Effect
First push the effect activation button above the flanger turning knob. Now the flanger effect is 
activated. By turning the flanger turning knob you can adjust the flanger effect‘s intensity. Push the 
effect activation button again in order to deactivate the effect.

42. Filter Effect
First push the effect activation button above the filter turning knob. Now the filter effect is acti-
vated. By turning the filter turning knob you can adjust the filter effect‘s intensity. Push the effect 
activation button again in order to deactivate the effect.
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43. Delay Effect
First push the effect activation button above the delay turning knob. Now the delay effect is acti-
vated. By turning the delay turning knob you can adjust the delay effect‘s intensity. Push the effect 
activation button again in order to deactivate the effect.

44. Key Mode (Harmonic Mixing)
With the Key Function it is possible to adjust the tone pitch independently from the tempo. The 
single tone is displayed in the field above as notes. This way you can harmonically mix tracks with a 
differing tone pitch.

45. Beat Loop/Auto Loop Function
Your Reloop Spin! 2 software disposes of an intelligent beat loop function. With this tool it is possible 
to create beat-matching loops with the push of a button, depending on the selected bar. This way it 
is not necessary to set the in and out points manually. 

Select the desired bar via the beat loop bar buttons (1/2 – 16 bars). Activate the beat loop via the 
beat loop button (when in beat loop mode this will flash). Deactivate the beat loop via the play/pause 
button -34-.

Operation via Keyboard:
• 	 �When in playback mode push “F4” (player 1) or “F12” (player 2) in order to activate the beat loop 

mode
• 	 �Via the keys “F5”/”F6” (player 1) and “F7”/”F8” (player 2) you can prolong or shorten the loop 

respectively
• 	 Push the space bar in order to quit the auto loop (select the active player via the TAB button)

46./47. Manual Loop Function
• 	 �In order to set a loop manually push the Loop In button at the desired starting point and the Loop 

Out button at the desired ending point.
• 	 By pushing this button again you will quit the loop
• 	 By pushing the Reloop Button you will return to the last set loop

48. Crossfader
The Crossfader is just intended for the PC control mode. When in regular Timecode Mode (external 
mixer) you will not need the crossfader. Via the fader you can crossfade from channel 1 to 2 and vice 
versa.

NOTE!
When in Timecode Mode the crossfader should be in the middle position.

Funktion Player 1 Player 2

Loop In F1 F8

Loop Out F2 F10

Exit [Reloop] F3 F11
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49. Beat Match Function
The Beat Match Function is a handy helping tool in order to match the pitch of two different tracks 
with the push of a button. You can either match the right player with the left player or you can match 
the left player with the right player.

50. Cue Points
It is possible to set up to 6 cue points per track. They will be permanently saved automatically until 
they are replaced by new ones.

• 	 �In order to set a cue point via mouse push the right mouse button at the desired time.
• 	 �In order to call up a cue point a click of the left mouse button suffices.
• 	 �If a cue point has been saved you will see a thick green mark on the corresponding cue button.
• 	 �Set the cue point for player 1 via the numbers 1 – 5 (only 5 cue points per player) and for player 

two via the numbers 6 – 0.
• 	 If you push the according number again the cue point will be called up (hot cue).

51. Info View

a) 	Title
	 �The title of the current track is displayed here. With a click of the right mouse button you can 

select whether only the title, only the artist or both should be displayed.

b) 	Elapsed
	 The elapsed time of the current track is shown here (minutes/seconds/frames).

c) 	Remain
	 The remaining time of the current track is displayed here (minutes/seconds/frames).

d) 	BPM
	 The current BPM value is shown here.

e) 	Repeat function
	 �Here you can (de)activate the track repeat function. If the repeat function is activated the loaded 

title will automatically be repeated.

f) 	Out port
	 �Here you can see which output signal of the interface is assigned to the player. If set up correctly 

“01” should be displayed on the left player and “02” on the right player. You can change the port 
by clicking on it.

g) 	Pitch
	 �Here the current pitch value is displayed.

a

b

c

d f

e g

Beatmatch Schnelltaste

Player 1 Y

Player 2 X
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52. Category View
The category view is a kind of fast search filter for the Spin! Library. You can choose whether the 
Spin! Library view should be displayed alphabetically, sorted according to years or BPM values for 
example. Under the point “groups” you can carry out playlists or sortings. In order to create a new 
group push the right mouse button in category view on the “Add Group” item. Now you will be asked 
to enter a name – confirm by pushing the enter button.

53. Music Explorer/Audio Input
The music explorer is a file browser in tree view just as you know it from the Windows explorer. Here 
you can search for files in your work centre or your network environment. Furhtermore here you can 
also find the Spin! 2+ Interface under the item “Audio Input”. Each input is listed there. Via drag & 
drop it is possible to drag single inputs onto the player for an easy assignment.

54. Monitor Function
Via the Software Monitor function you can monitor a track. This function is unnecessary when using 
an external mixer as you would monitor a track via the mixer‘s cue function.
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3. Reloop Spin! 2 Menu Navigation

In this chapter all menu items will be described step by step.

3.1 Menu Item File

3.1.1 Options
In this option menu you can carry out a variety 
of adjustments. Further information regarding 
this matter can be found in the chapter 4.1 in 
this manual.

3.1.2 Learning
With the „Enable“ button you activate the MIDI 
Learning Function. Please also refer to chapter 
4.4.

3.1.3 Quit Spinning
Here you can quit the Reloop Spin! 2 software.

3.2 Menu Item Spin! Library
With the Reloop Spin! Library you can manage 
your audio files. If desired it is possible to create 
and store various libraries. You can import music 
to the Spin! Library in order to obtain a central 
collecting station of your files. It is possible to 
edit and export new libraries and you can also 
import libraries (for example iTunes playlists).

3.2.1 New
Here you can create a new, empty library that 
can be filled with audio files as required.

3.2.2 Open
Opens an existing library.

3.2.3 Save
Saves your library.

3.2.4 Save as...
Saves your library under a different name wit-
hout deleting the previous one.

3.2.5 Import
Imports files [ iTunes (*.xml) / m3u Files (*.m3u)]

3.2.6 Export
Exports files [m3u Files (*.m3u)]

3.2.7 Automatic Search
In order to import a bulk of audio files you can 
comfortably browse your hard disk or if required 
single directories via this function.

3.2.8 Add Track
With this function you can add single tracks to 
your library.

3.2.9 Select All
With this function you can select all tracks from 
a library.

3.2.9.1 Delete
With this function it is possible to delete files 
from your current library without deleting them 
from your hard disc.

3.3 Track Menu

3.3.1 Track Preferences
You can carry out track-specific adjustments 
here.

3.3.2 Save ID3 TAG Attributes
If you want to change ID3 TAG attributes you can 
save these.

3.3.3 Show in Windows Explorer
With this function it is possible to display the 
marked track in Windows Explorer.

3.3.4 Analyze BPM Manually
Via this tool you can manually determine the 
BPM value. This can be achieved by either cli-
cking on the space button with the mouse or by 
pushing the space bar. The longer you push the 
according button to the beat the more precise 
the calculated value will be.

3.3.5 Analyze BPM Automatically
Via this function the BPM value will be calcu-
lated automatically although beats cannot be 
recognized by the software if the beat does not 
stand out enough from the rest of the track in 
order to be identified as rhythm element. 4/4 
beats are ideal for the Reloop Spin! 2 software.

NOTE!
Several tracks can be analysed automatically. 
If a track is loaded to a player for the first time 
the BPM value will automatically be determi-
ned and saved permanently.

3.3.6 Delete Tracks Permanently.
Via this function it is possible to delete tracks 
permanently.

ATTENTION!
In this case the track will be deleted perma-
nently from your hard disc and not only from 
the library.
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3.4 Spin! List Menu
The Spin! List is a kind of “party” playlist. The 
featured tracks will be played and crossed over 
alternately from player 1 and player 2. This func-
tion is ideal if you want to operate the software 
in stand-alone mode without a DJ.

3.4.1 Play Spin!List
Starts the playback of a Spin! List.

3.4.2 Stop Spin! List
Stops the playback of a Spin! List.

3.4.3 Add to Spin! List
Adds the currently selected track to the Spin! 
List.

NOTE!
You can also add tracks to the Spin! List via 
drag & drop. 

3.4.4 Safe Mode
If the safe mode is active it is not possible to 
load a track to the currently active player. This 
prevents unwanted loading of new music when 
using a player.

3.5 Spin! 2 Workspace Menu
In this menu you can fade in and out single ele-
ments in order to individually arrange the view.

3.5.1 Workspace Arrangeable
If this is activated it is possible to rearrange and 
close single window elements.

3.5.2 Tool Tips
Activates the Tool Tips function. By activating it 
an information window will appear when moving 
the mouse cursor over single elements.

3.5.3 Bar
Activates the extended Beat Bar function in 
Beat Match View.

3.5.4 Full Screen View
Activates the full screen view. Alternatively 
this can be carried out via the key combination 
ALT+S.

3.5.5 Menu Bar View
Fades the menu bar in and out.

3.5.6 Shortcut View
Fades the shortcut view in and out.

3.5.7 Info View
Fades the info view in and out.

3.5.8 Preview
Fades the preview bar in and out.

3.5.9 Spin! Library View
Fades the Spin! Library in and out.

3.5.9.1 Spin! List View
Fades the Spin! List in and out.

3.5.9.2 Category View
Fades the category view in and out.

3.5.9.3 Music Explorer/Audio Input
Fades the music explorer / audio input view in 
and out.

3.5.9.4 X-fader Match View
Fades the X-fader match view in and out.

3.5.9.5 Master/Rec Volume
Fades the master/rec volume view in and out.

3.5.9.6 Beat Match View
Fades the Beat Match view in and out.

3.6 Help Menu

3.6.1 Easy Setup
Via this you can call up the easy setup.

3.6.2 Manual
Via this you can call up the manual as PDF file.

3.6.3 www.reloop-spin.com
Via this you can visit the web site reloop-spin.
com. Visit this site frequently in order to obtain 
current downloads or information.

3.6.4 Configuration Log
Via this a current system-configuration over-
view will be created as text file. This could be 
required when trying to solve possible problems.

3.6.5 About Spin!
Here the current Spin! version is displayed.
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4. ADJUSTMENTS

4.1 Options
You can reach the options menu under > File > Options.

4.1.1 System 

1. Load Last Track
If this option is activated the last played track 
and Spin! Library will be loaded when starting 
the software.

2. Record Play
If this function is activated all played tracks will 
be saved in a list with date and time. By pushing 
the “View List” button you can call up this list.

3. TAGs
Here you can select which ID3 TAG version 
should be displayed. Only one optoin should be 
selected here.

4. Play List Directory
Here you can determine the path where the 
Spin! List should be saved/loaded.

5. Waveform Directory
Here you can determine the path where the 
waveform peaks should be saved.

6. Software Multi Open
If this function is activated Reloop Spin! can be 
opened several times at once (not recommen-
ded/depends on ASIO).

7. Sound Before Graphic Priority
If this function is activated the sound perfor-
mance will be assigned before graphics. This 
is an advantage when using older or inefficient 
computers (when experiencing dropouts for ex-
ample).

8. Load Track to RAM
Here you can determine how fast the track 
should be loaded to RAM (slow/normal/fast).

9. Load Track in RAM/min.
Here you can determine the maximum track 
length in minutes that should be loaded to RAM.

10. Easy Keyboard Search
If this function is activated you can browse 
tracks in the Spin! 2 library and music explorer 
by simply typing in a letter.

11. Tone itch
Here you can adjust the percentage that the 
tone pitch should be played in (also see chapter 
2, item 30).
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4.1.2 BPM and Tools

1. BPM Range
Here you can adjust the BPM range that the soft-
ware should use to calculate. The smaller the dif-
ference the faster and more precisely Spin! can 
calculate. By default the range is 78 – 150 BPM.

Recommended settings:
• All-Round 78 – 150 BPM
• Hip Hop 80 – 120 BPM
• House/Techno 110 – 150 BPM

2. Show Pitch Value
Activates the pitch display (default setting and 
recommended).

3. Calculate BPM on Load
If this option is activated Spin! determines the 
BPM and waveforms when loading a track (de-
fault and recommended).

4. Auto Gain
If this function is activated the gain values of 
tracks with a different volume level will be mat-
ched. This way a manual matching via the Gain 
Knob -29- is no longer necessary.

5. Auto Cue
Via this you can turn the auto cue function on/
off.

6. First Cue Point Search
Via this you can determine the time frame in se-
conds for the first cue point search.

7. dB Sensitivity
Here you can adjust the sensitivity in decibel 
and corresponding threshold level that should 
be used for setting a cue point.

8. Fading Time
Here you can adjust the crossfading time for the 
auto mix function of the Spin! List.

9. End of Track Warning
Here you can adjust the optical end of track war-
ning-time in seconds.
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4.1.3 Audio Devices

1. Output Device
Here you select the Reloop Spin! 2+ Interface and it should be displayed here.

2. Out Ports
Here you can determine the number of outputs. A “2” should be entered here.

3. Setup
Here you can adjust the single outputs for the left and right side. Furthermore you can adjust the 
buffer size via the button “Control Panel” in the ASIO setup.

NOTE!
All audio device settings have been automatically adjusted in the easy setup; this way you do not 
have to carry out any changes here.

1

1

1
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4.1.4 Timecode

In this detailed timecode menu several adjustments for player 1 and player 2 can be carried out 
although they are not necessary if the easy setup was successful. You should carry out advanced 
settings for optimazation and solving problems only.

1. Timecode from
Here you can set the timecode source, vinyl or CD.

2. Spin! Mode
Here you can select the Spin! mode (see chapter 2, item -33-).

3. Audio Device
Here the ASIO driver should be selected.

4. Audio Source
Here you can assign the corresponding connections of your Spin! 2 interface.

The default settings are:
Player 1: 0: Reloop Spin!-Interface 1 – Reloop Spin!-Interface 2
Player 2: 2: Reloop Spin!-Interface 3 –Reloop Spin!-Interface 4

5. Timecode Quality
Here the timecode‘s signal quality is displayed in percentages. Fluctuations or a percentage that is 
too low could be caused by dirty or worn out needles. Ideally the value should be between 90 – 100%.

6. Adjust Gain
Here the decibel value of the input signal for the left and right side can be adjusted. The virutal LED 
chain serves as modulation display. This value should only be changed manually when trying to solve 
a problem. In the easy setup the ideal gain value will be configured automatically for you.
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7. Direct Phono Input
Here you can define whether a turntable has been directly connected to the computer. When using 
the Spin! 2+ interface (line output) a “No” must be displayed here.

8. 45 RPM
Here you can determine whether the timecode records should be played at 45 RPM (Rounds Per 
Minute). Default setting and usual is 33 RPM.

9. Left/Right Inverse
When using certain needles or when having calibrating problems it could be that the left and right 
side have been mixed up. For the software sector this can be re-adjusted via this option.

10. Phase Inversion
Some cartridges such as the Shure M44-7 need a phase inversion. Activate it here.

11. Timecode Start Delay
Here you can determine the starting point of your timecode record. As usually the first third of the 
record is likely to be worn out first it is possible to offset the starting point to a desired position. To 
do so place the needle on the desired starting point and push “Save Position”. The value is displayed 
in milliseconds.

12. Noise Level/Noise Filter
These two values are only intended for optimisation and for solving problems. Due to easy setup 
these values have already been configured.

• 	 Noise Filter:
	 �When experiencing grounding problems or something similar you can increase the noise filter to 

150 for example in order to improve the input signal. The louder the noise the higher the frequen-
cy should be raised.

	 ATTENTION!
	 The timecode‘s precision could decrease if the noise filter is set too high.

• 	 Noise Level:	
	 �Here you can adjust the noise level in decibel. For a better sensitivity the value should be increa-

sed. Default setting is 40 dB.

13. Calibration Display
Here the timecode signal is displayed optically. Ideally the signal should look like a sinus curve.
If the signal is distorted (square wave) you should check your needles or adjust the settings as de-
scribed above.

14. Circle Diagram
Alternatively the calibration display can be shown as a circle diagram. To do so activate this button.

15. Calibrate Button
Push this button in order to calibrate the respective player automatically with the pre-set options.

16. 1 Turntable Mode
If you wish to use only one turntable you should activate this mode in order to control both players. 
Make sure that the same interface input is selected under “Audio Source” (see item 4).

TIP!
You can choose between the players via the TAB button.

17. More Options
Activate this button in order to fade in the advanced options (noise level / noise filter and 1 turntable 
mode)

18. Apply
Push this button in order to apply the adjustments. Then push “OK” in order to quit the menu.
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4.1.5 Workspace

1. Resolution Selection
The available resolutions are listed here. Select the according resolution for your monitor.

2. Apply
Adopt the settings via the Apply Button.

NOTE!	
Performance Skin
When in Resolution Selection you can also choose a compact P erformance Skin according to 
your resolution. In this simplified display only the basic elements are displayed that are needed 
for classic mixing. Cue-Points, Effects, Beat Match or large Label Monitors are not available. A 
further advantage of this display is the maximised Library section that is especially tailored to 
laptop computers that dispose of a smaller resolution.

1
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4.1.6 Shortcuts

1. Shortcut Setting File
Here you can select the hot key layout for your keyboard.
The following options are at your disposal:

• 	 Spin_keyboardQWERTZ 
	 (Germany, Austria, Switzerland, Hungary)

• 	 Spin_keyboardQWERTY
	 (America, England, Netherlands, Italy, Scandinavia, Poland, Spain, Portugal)

• 	 Spin_keyboardAZERTY
	 (France, Belgium)

2. Layout Preview
Here the keyboard layout is displayed in a preview.

1

2
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4.1.7 MIDI Controller

1. Activate MIDI
Via this you can activate the MIDI operation for Spin!

2. MIDI Device
Here you can find a list of compatible MIDI controllers, for example Reloop Digital Jockey (www.
digital-jockey.dj).

3. MIDI Setup File
The pre-configured MIDI configuration files are listed here.

4. Omni Mode
If this option is activated Spin! will receive on all channels.

Note!
Please check regularly for Spin! updates under www.reloop-spin.com in order to download new 
MIDI mappings for example.
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4.2 Auto Search

Via the Auto Search Function you can easily locate music files on your hard disk and add them to 
your Spin! Library.

1. Path
The currently selected path is shown here.

2. Select Directory
Via this function you can select single folders.

3. Add Directory
If this option is activated a directory will be added.

4. All Drives
Select this option in order to select all drives from your work space and search for tracks.

5. Subdirectories
If this option has been selected subdirectories will also be considered when searching.

6. No Duplicate
If this option is activated the already added tracks will not be added again to the Spin! Library when 
searching in the same directory for a second time.

7. Advanced Search
Categories such as artist, title or genre can be filtered here while searching.

8. Exact Search
If this option is activated only exact matches will be added.

9. All Fields Search
If this option is activated all category fields will be searched.

10. Initialize Spin! Library
If this option is activated the Spin! Library will be initialized.
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4.3 Track Preferences
In the track preferences you can activate these settings and data of a track. You can reach the track 
preferences under the menu item: 

> Track > Track Preferences 

or by clicking the right mouse button on the track in the Spin! Library.

4.3.1 Information
Here you can see and edit various information like title, artist or label for example. Additionally it is 
possible to save comments to a track.

4.3.2 File
Here you can see information regarding saving location and audio quality.
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4.3.3 Track Settings
Here you can see and edit settings such as starting and ending points, loops or tempo.

4.3.4 Volume
If desired you can preset gain, pan or fade in/out for a track. 
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4.3.5 Lyrics
If desired you can enter and view song lyrics here.

4.3.6 Artwork
Here you can upload and see cover artwork for a track.
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4.3.7 Equalization
Here you can adjust the EQ settings.

4.3.8 Cue Points
Here you can pre-define up to 10 cue points if required.
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4.3.9 Loop
Here you can pre-define up to 10 loops if required.

4.4 MIDI Learning
With the Free MIDI Learning Function you can assign MIDI commands to single software elements. 
To do so activate the  Free MIDI Learning Function by clicking the button in Shortcut View or under 
File>Learning>Enable. Now choose an element by moving the mouse cursor over an element and wait 
shortly. The corresponding element will be marked. Confirm the desired MIDI hardware controller in 
order to assign it to the element. This way you can control the Spin! 2 software via MIDI keyboards 
or DJ controllers.

Deactivate the button again in order to quit the MIDI Learning mode. It is possible to create, select 
and edit MIDI presets in the MIDI control mode (> File > Options > MIDI Controller).



E
N
G
L
IS
H

44

5. MIDI Mapping

21(15H)
85(55H)

01(01H)
65(41H)

05(05H)
69(45H)

22(16H)
86(56H)

23(17H)
87(57H)

09(09H)
73(49H)

27(1BH)
89(5BH)

04(04H)

14(0DH)
77(4DH)

06(06H)
70(46H)

10(0AH)
74(4AH)

02(02H)
66(42H)

24(18H)
86(58H)

25(19H)
87(59H)

26(1AH)
88(5AH)

16(10H)
80(50H)

13(0CH)
76(4CH)

08(08H)
72(48H)

11(0BH)
75(4BH)

07(07H)
71(47H)

03(03H)
67(43H)
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6. FAQ

6.1 Do I need a special stylus in order to use Spin! 2?
No. Spin! 2 will work with every needle. Still, some things should be considered to guarantee a 
smooth performance:
Your needle should neither be worn out nor be dirty/dusty. If you use a headshell-mounted system 
please be sure that it is aligned properly. Also its output voltage should be as high as possible to 
ensure a „clean“ timecode stream. This is why we bundled the Ortofon Digitrack System with Spin! 
2: due to its „Concorde“-design you dont have to make any adjustments and its very high output 
(8mV) makes sure that the timecode stream is always nice and clean.

Generally speaking every turntable is Spin! 2 compatible. The better the turntable (e.g. Reloop RP-
6000 MK6) the better the results (scratch characteristics, speed droop).

6.2 Can I buy the timecode vinyl records separately?
Yes, of course. Timecode vinyl records wear out quicker than normal vinyl because you don‘t change 
them after every song. Besides the normal wear and tear your records get while being used, oil or 
grease will degrade the quality of your timecode vinyl. Because of that your dealer has spare re-
cords. They come in black, white and atomic green.

6.3 Why won‘t my computer recognize the Spin! interface?
There may be several reasons. We would recommend to unplug all your USB devices to eliminate 
conflicts with USB soundcards for example.
Also we advise you not to use a hub to connect Spin! 2 to your computer. If possible, always make a 
direct connection.

6.4 Why is there no timecode signal from one turntable? One turntable can play MP3 files, only 
the second one does not work as Spin! says that it cannot find a timecode signal?
Go to „Options/ Timecode“ and check if any waveforms are displayed. If there is only one waveform 
displayed then there is a faulty connection between your needle and the interface. In order for 
Spin! 2 to work it needs to read TWO waveforms. Just to clarify: that means TWO waveforms PER 
PLAYER, shown in red and white. First, swap your needles. If the problem migrates along with your 
needle to the second turntable then your needle is either dirty/ broken or the contacts are dirty. Use 
a q-tip and some cleaning alcohol to clean both the contacts on the cartridge and in the tonearm. 
Please do NOT spray contact spray or anything else into the tonearm! You can check whether you 
get a stereo signal out of your turntable by playing a normal record and using the panorama knob on 
your mixer. If both needles work on one of the turntables but not on the second turntable then you 
probably have a bad RCA cord. Please replace it. If the audio cords are permanently attached to your 
turntable then contact your specialized dealer / technician and ask for help.

6.5 Why do I only hear a high-pitched tone?
You‘re listening to the timecode stream because you activated „Vinyl Bypass“, located right above 
the Label Monitor. In your case, you‘re playing the timecode vinyl. Deactivate „Vinyl Bypass“ and the 
control vinyl will play your digital music.

6.6 Why is the music playing in reverse?
Your turntable is playing normally yet your music is playing backwards? Your turntable may be 
hooked up incorrectly. Your cables are mixed up- the left and right channels of your turntable are 
reversed. Simply swap them and everything should be back to normal. If for some reason you can‘t 
swap the cables then go to „File-> Options-> Timecode“ and check the box next to „Left/Right Inver-
se“. Basically this has the same effect as swapping your cables would have, however, it is always a 
better to have your equipment connected correctly.

6.7 Can I play my records at 45 RPM instead of 33 RPM?
Yes. Go to „File -> Options -> Timecode“ and check the box next to „45 RPM“. Now re-calibrate Spin! 
2 (make sure that the turntable‘s pitch fader is set to „0“). 

6.8 Why are both tracks being played on the same channel?
Both players are routed to the same OUT PORT. In the Info Screen, click on the number after „Out 
Port“ to change the routing. Typically you will want to route the left channel to Port 1 and the right 
one to Port 2.
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6.9 Why is there no signal?
There are several possibilities, please check the following:

• Is your mixer/amp turned on? Are gain, line and master controls turned up?
• Did you choose the correct input on your mixer (phono instead of line)?
• Is vinyl control activated? (Button „Vinyl“ below the Label monitor has to be green)
• Is Spin! 2 correctly configured?
• Have all the cords been plugged correctly?
• Does Spin! 2 recognize the timecode?
• Is a microphone plugged in? Unplug the mic, it blocks Input 1.
• Is the correct Out Port set? Left Player: Out Port 1, right player: Out Port 2.

6.9.1 Can I use the interface as a sound card?
You can use the Spin! 2 interface as a mobile USB sound card with two stereo inputs and two stereo 
outputs. Also it features a microphone input with adjustable gain. If you use the mic input it will work 
instead of stereo input 1.

6.9.2 What do I have to observe if I use a Shure M44-7?
This cartridge will need a phase inversion. Go to „File -> Options -> Timecode“ and tick the box next 
to „Phase Inverse“.

6.9.3 Why is the music skipping a beat now and then?
The cause may be a hard disc that is too slow. One solution is to set the setting “Load Tracks to 
RAM” to “rapid” under “options>system”. Furthermore it is recommended to defragment the hard 
disc where the tracks are stored in order to optimize the reading abilities.

6.9.4 Why does the speed / the pitch of my tracks fluctuate?
There are several reasons for this:

• Spin! 2 is not calibrated
• the neddle is dirty/ dusty
• there is too much weight on the needle
• the needle is worn out
• the timecode vinyl is worn out (scratches, cue burn) or dirty

6.9.5 Is there an auto mix/party mix function?
Yes. Add some tracks to the Spin! 2 list (NOT the Spin! 2 library) and select „play Spin! 2 list“ by 
right-clicking into the list. The tracks will be played alternately between both players.

6.9.6 How can I optimize the performance of Spin! 2?
A computer with decent performance and stability is important in order to have Spin! 2 running 
reliably. Here are some tricks:

• �Open the settings for your system performance in your control panel under „System>Advanced“. 
Here select the setting „adjust for ideal setting“.

• Deactivate any LAN / WLAN and network devices.
• Deactivate virus scanners and power managment software.
• �In Windows, go to „System Properties ->Advanced -> Performance Options“ and tick „Background 
services“ in your Windows settings

• Defragment your hard disc
• Don‘t have other programs running in parallel with Spin! 2.
• In Spin! 2, go to „File -> Options“ and tick „Sound before graphic priority“
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6.9.7 What can I do if I hear humming or buzzing when using a laptop?
Try to disconnect the mains adapter from your laptop. If the humming is no longer audible this is a 
grounding problem. You can try to solve the problem via the following procedures:

• Try to use a mains adapter without grounding.
• Try to connect all your devices to only one circuit.
• Try to place the mains and RCA cords separately.
• Check if your turntable is grounded correctly.
• Try to connect an anti-buzzing filter.

6.9.8 Why is the signal distorted, why is there too much bass, why are the high frequencies mis-
sing?
Please check if Spin! 2 2 Interface‘s outports are connected to the line inputs of your mixer (not to 
phono input).

7. HOT KEY OVERVIEW



E
N
G
L
IS
H

48

8 Spin! 2+ Interface Specification

1. GENERAL SECTION
MODEL: ..................................................................... SPINU2A
POWER SOURCE: .................................................... USB5V, 500mA
DIMENSION: ............................................................. 180(W) x 137(D) x100.2(H) mm
WEIGHT: .................................................................... 0.78 kg

2. FEATURES:
•	4 Channel analog input/output with through output.
•	High level master output.
•	Phono/Line selector with gain adjust.
•	Midi control panel.
•	Earphone output with direct switch, split adjust and gain adjust.
•	Input/output signal indicate by LED.
•	Microphone input with active voltage supply, gain adjust and throughout.
•	USB V1.1 Connect Computer RECORD&PLAY.

3. INPUT/THROUGH OUT SECTION: .................... (LINE IN: -14dBV, LOAD= ? OHM)
CH. BALANCE: ......................................................... Within 0.5 dB
LEVEL DIFFERENCE: ............................................. Within 0.5 dB

4. PLAYBACK SECTION:......................................... �(Microphone switch off, Windows playing speaker 
maximum, Phones load= 33 ohm, Line out load= 
47K OHM)

FREQUENCY RESPONSE:....................................... �(Phones out= 0 dBV output; TCD781 Track 1, 4(for 
line), 6(for phones), 18)

LINE: .......................................................................... 17-20K Hz ±2 dB
PHONES: ................................................................... 61-20K Hz ±3 dB
THD + N: ................................................................... �(Phones out = 0dBV OUTPUT, A-Weighted, W/20KHz 

LPF; TCD781 Track 1)
PHONES: ................................................................... Less than 0.1%
MAXIMUM OUTPUT: ............................................... (TCD781 Track 1)
LINE: .......................................................................... �THD<=0.02%,More than +6 dBV (2.0V) 

at load = 47K OHM
PHONES: ................................................................... �THD<=1%,More than +1.6 dBV (1.2V) 

at load = 33 OHM
OUTPUT NOISE: ...................................................... �(W/20KHz LPF, A-Weighted, 

playback TCD781 track 1 then pause)
PHONES: ................................................................... Less than -70 dBV(Adjust Gain Maximum)
S/N RATIO: ............................................................... �(W/20KHz LPF, 

Phones out=0dBV,A-WEIGHTED; TCD781 Track 1)
LINE: .......................................................................... More than 85 dB
PHONES: ................................................................... More than 75 dB
CH. SEPARATION: ................................................... (W/20KHz LPF, A-Weighted; TCD781 Track 32,38)
LINE: .......................................................................... ���More than 85 dB at 1K Hz between L and R. 

More than 85 dB at 1K Hz between channels.
PHONES: ................................................................... More than 65 dB at 1K Hz between L and R.

CH. BALANCE: ......................................................... (Phones out = 0dBV; TCD781 Track 1)
LINE: .......................................................................... Within 1 dB
PHONES: ................................................................... Within 1 dB

FADER MAXIMUM ATTENUATION:....................... �(1K Hz Line in= -14 dBV and Phones out = 0 dBV, 
A-Weighted W/20K Hz LPF; TCD781 Track 1)
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SPLIT FADER
PC to PHONES:......................................................... Less than -75 dBV
LINE IN to PHONES: ............................................... Less than -70 dBV
MICROPHONE SECTION:........................................ �(Microphone switch ON, 

1KHz -50 dBV input,48 V OFF)
FREQUENCY RESPONSE: ..................................... (Microphone gain maximum)
LINE1 OUT: ................................................................ 20-20K Hz ±3 dB
THD+N: ..................................................................... (A-Weighted, w/ 20k Hz LPF)
LINE1 OUT: ................................................................ Less than 0.2%
MAXIMUM OUTPUT: ............................................... �(THD=1%, Adjust Microphone gain, 

A-Weighted, w/ 20k Hz LPF)
LINE1 OUT: ................................................................ More than +5.5 dBV (1.9V) at load = 47K OHM
OUTPUT NOISE: ...................................................... �(Microphone gain maximum, 

disconnect Mic, W/20K Hz LPF, A-Weighted)
LINE1 OUT: ................................................................ Less than -55 dBV
S/N RATIO: ............................................................... �(W/20KHz LPF, 

MICROPHONE GAIN MAXIMUM, A-Weighted)
LINE1 OUT: ................................................................ More than 60 dB

5. RECORDING AND PLAYBACK SECTION: ....... �(Windows playing speaker and all 
gain control are maximum)

INPUT/OUTPUT IMPEDANCE & SENSITIVITY: .. �(1KHz recoding MASTER +6 dBV OUTPUT, 
load = 47K OHM )

LINE IN: ..................................................................... 10-50K OHM / -14 dBV (200mV) ±2 dB
PHONO: ..................................................................... 47K OHM / -54 dBV (2mV) ±2 dB
MIC: ............................................................................ 2.2K OHM / -50 dBV (3.16mV) ±2 dB
S/N RATIO: ............................................................... (1KHz recording,W/20KHz LPF, A-Weighted)
LINE: .......................................................................... More than 85 dB
PHONO: ..................................................................... More than 85 dB
MIC: ............................................................................ More than 60 dB
FUNCTION BALANCE: ........................................... �(Recording 1K Hz and playback to Line out, 

W/20K Hz LPF, A-Weighted)
PHONO: ..................................................................... +/- 2 dB (Reference to LINE OUT)
PHONES: ................................................................... �+/- 2 dB (Reference to DIRECT ON, 

playback signal with DIRECT OFF)
MIC: ............................................................................ �+/-2 dB (Recording 1K Hz with MIC ON, 

playback signal with MIC OFF)
FREQUENCY RESPONSE: ..................................... (Reference recording 1KHz, load= 47K OHM)
LINE: .......................................................................... 20-20K Hz +2/-3 dB
PHONO: ..................................................................... �20-20K Hz +2/-3 dB

(RIAA: Input 1K Hz/-50 dBV, 20 Hz/-69.3 dB, 	
20K Hz/-30.4 dB)

THD + N: ................................................................... �(Recording 1KHz and playback to Line out, 
A-Weighted, W/20K Hz LPF)

LINE: .......................................................................... Less than 0.05%
MIC: ............................................................................ Less than 0.15%


